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Micro Focus Enterprise Developer 2.1 for
Eclipse Release Notes

These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.

Note: This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link. Web
sites by their nature can change very rapidly and although we try to keep our links up-to-date, we
cannot guarantee that they will always work as expected.

Important: Application executables that were compiled using earlier Micro Focus products must be
recompiled from the sources using Enterprise Developer. For more information, read the section
Upgrading to Enterprise Developerfor Eclipse in the product Help.

Enterprise Developer is a contemporary development suite for Eclipse that allows mainframe developers to
maintain, develop and modernize mainframe applications regardless of whether these are to be deployed
back on the mainframe or onto alternative platforms.

Enterprise Developer supports IBM COBOL, IBM CICS, IBM JCL, IBM DB2, IBM z/OS file formats and
common batch utilities including SORT. This means that the core mainframe online and batch applications
can be developed and maintained under Enterprise Developer. These applications can then be deployed
back on the mainframe or migrated onto one of the Micro Focus Linux, UNIX or Windows based production
platforms.

Enterprise Developer comes in three product variants:

Enterprise
Developer
Personal Edition

Enterprise Developer Personal Edition is a free product, available for download. It is
suitable for anyone who wants to become familiar with the Eclipse or Visual Studio
means of editing and compiling mainframe applications under Windows.

Enterprise
Developer

Enterprise Developer is for customers looking to modernize mainframe applications
and move to an alternative platform. This option again uses either the Visual Studio or
Eclipse-based IDE and includes development and test tools for all platforms currently
supported by Micro Focus.

Enterprise
Developer for z/
Enterprise

Enterprise Developer for z/Enterprise targets customers modernizing applications for
deployment back on the mainframe or any of the z/Enterprise partitions. This option
uses the Visual Studio or Eclipse-based IDE, mainframe integration and workflow
management. It also includes tools to support development and test on z/Linux and
AIX and x86 environments.

Note:

If you are currently using the Personal Edition variant and you want to use the full function edition,
please contact your Micro Focus representative and ask for a free trial.

If you are currently using either Personal Edition or the full edition and you want to try Enterprise
Developer for z/Enterprise, please contact your Micro Focus representative and ask for a trial.
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Installing Enterprise Developer

System Requirements

Hardware Requirements
The disk space requirements for Windows are:

• Approximately 42MB for the Sentinel RMS license server.
• At least 1GB for Enterprise Developer.

Note: This includes the space needed to cache information locally so that you can modify the
installation without the original source media.

The disk space requirements for UNIX/Linux are:

• Between 26 and 35 MB for the Sentinel RMS license server depending on the platform.
• Between 206 and 427 MB for Enterprise Developer depending on the platform.

Important: The UNIX installation requires extra disk space that equals the size of the product you
install.

Operating Systems Supported
Note: You can produce 64-bit and 32-bit applications on 64-bit operating systems.

The supported Windows platforms are:

• Windows 7 32/64-bit
• Windows Server 2008 SP2 32/64-bit
• Windows Server 2008 R2 32/64-bit

Note: This product can be installed on earlier versions of Windows but it has not been tested on
them.

The supported UNIX and Linux platforms are:

• POWER running AIX 6.1, 6.6, 7.2 - 32/64-bit
• x86-64 running Red Hat Linux 5.5, 5.8, 6.2, Oracle Linux 6.2 (Red Hat Kernel compatibility mode) -

32/64-bit
• Oracle Linux 6 Update 2 with Unbreakable Enterprise Kernel Release 2
• SPARC running Solaris 10, 11 - 32/64-bit
• x86-64 running SuSE SLES 11, 11 SP2, Oracle Linux 6.2 (Red Hat Kernel) - 32/64-bit
• 390 running SuSE SLES 11 SP1 - 32/64-bit
• Itanium running HP/UX 11.31 - 32/64-bit
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Software Requirements

Windows

Note: If you use the Micro Focus Web Installer to install this product, it checks your system and
installs the missing prerequisite software.

UNIX/Linux

• Before installing on Red Hat 6.1, you must have the 32-bit operating system libraries installed:

GNU Standard C++ Library - libstdc++(i686 version)
The object files for development using standard C libraries – glibc-devel (i686 version)

Check the Red Hat Web site for more information.
• To use the Web installer on Red Hat Enterprise Linux 6.1, you must have the following bug fix updates

for Red Hat installed:

glibc-2.12-1.25.el6_1.3.i686.rpm
openldap-2.4.23-15.el6.i686.rpm
nss-pam-ldapd-0.7.5-7.el6.i686.rpm
zlib-1.2.3-25.el6.i686.rpm
nss-3.12.9-9.el6.i686.rpm
nss-util-3.12.9-1.el6.i686.rpm
cyrus-sasl-lib-2.1.23-8.el6.i686.rpm

You do not need these updates if you use the full product setup file to install the product.

• You need to install Xterm, the terminal emulator for the X Window System. Xterm is part of your Linux/
UNIX distribution but is not installed by default. Use your Linux/UNIX installation media to install it.

• Set the JAVA_HOME environment variable. When installing the product, set this variable to a 32-bit
Java installation or the installation terminates. For example, execute the following:

JAVA_HOME=java_install_dir

where java_install_dir is the path to the JAVA installation directory such as /usr/java/javan.n
• Add $JAVA_HOME/bin to your system PATH variable. To do this, execute:

export PATH=$JAVA_HOME/bin:$PATH

• Set the LANG environment variable to pick up localized messages. The LANG settings are English and
Japanese only.

Other Requirements

Important: This release requires version 10000.2.990 or later of the Micro Focus licensing software.
For local servers, you do not need to install it separately, as the setup file installs a new Enterprise
Developer client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus Licensing System Administration tool. To check the version of the license server on UNIX,
run /var/microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com/websync/SLM.aspx.
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Installing Enterprise Developer for Eclipse

Installation Restrictions and Requirements
Before starting the installation on Windows, you should consider the following:

• Enterprise Developer and Enterprise Server cannot co-exist on the same machine.
• Visual COBOL and Enterprise Developer cannot co-exist on the same machine.

Downloading the Product
1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the install instructions and the End User License Agreement.

Installing
To use the Web Installer:

1. Double-click the EnterpriseDeveloperEclipse21_webinstaller.exe file.
2. Click Start in the Installer window and follow the instructions to install the prerequisite software and the

product.

Alternatively, you can use the setup file on your machine and install the product as follows:

1. Run the EnterpriseDeveloperEclipse21.exe file and follow the wizard instructions to complete
the installation.

A full version of Eclipse, with the Micro Focus plugins already installed, will be present in the C:\Users
\Public\Micro Focus\Product Name\eclipse directory.

Note:

• If you are installing onto a machine that has an existing Micro Focus product that uses an older
Sentinel RMS License Manager, you might be prompted to remove it and install the Micro Focus
License Manager. By doing this you maintain the existing Sentinel RMS license files while adding
the Micro Focus License Manager. If you are unsure about existing licenses on your computer or
removing the Sentinel RMS License Manager, consult your System Administrator. If you want to
proceed, remove Sentinel RMS License Manager by using Windows Add or Remove Programs
and rerun the installation file.

• Trial licenses cannot be used with remote desktop services. If you want to use your product in this
way, please contact Micro Focus SupportLine to obtain a relevant license.

• We recommend that you install any updates for the .NET Framework that are available at the 
Microsoft Download site.

• If you install JDK you might be prompted to install the latest update. The latest update is not
required for use with Enterprise Developer but you can install it if you wish.

Installing Silently on Windows
You can install Micro Focus products silently by using command line parameters to specify the installation
directory, user information, and which features to install.

To install silently use the following command:

start /wait install-file.exe /q [parameters]

where install-file for the following products is as follows:
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Enterprise Developer EnterpriseDeveloperEclipse21.exe

The installation file includes a number of individual .msi files, where each .msi file installs one software
component. For instance, EnterpriseDeveloperEclipse21.exe includes one .msi file to install
Enterprise Developer and another to install License Manager; running
EnterpriseDeveloperEclipse21.exe installs both Enterprise Developer and License Manager.

You can specify different parameters for the different .msi files within the same .exe file by using the /
componentargs parameter. Valid values for the /componentargs parameter are as follows:

• License Manager
• Enterprise Developer

The examples show how to use the /componentargs parameter.

After the installation is complete you can install the license silently. You need to have your Authorization
Code. To install the license execute:

start /wait <install-dir>\bin\cesadmintool –term activate AuthorizationCode

Directory Considerations

• You must have read and write access for every directory accessed during the install.
• You can override the default installation folder using the INSTALLDIR parameter:
• If a path in a definition contains spaces, then the path must be preceded by a backslash and double

quotation mark (\"). For example:

INSTALLDIR=path
INSTALLDIR=\"c:\MyProduct\" 
INSTALLDIR=\"c:\Program Files\Micro Focus\My Product\"

• Installing creates a log file in %temp%\LogFilename by default. To change the location or name, use
the /l parameter on your Setup command line and specify the path and file name, for example:

/l*v drive:\path\LogFilename

The default names for the log files are as follows:

EnterpriseDeveloper_install_log.txt for the Enterprise Developer wrapper

EnterpriseDeveloperx??
_install_log.txt

for Enterprise Developer, where ?? is "86" for 32-bit
systems and "64" for 64-bit systems

lmsetup_install_log.txt for License Manager

• The log filename and folder name cannot contain spaces
• The log file folder must exist before beginning the silent install

Examples

• To silently install Enterprise Developer into a directory other than the default:

start /wait EnterpriseDeveloperEclipse21.exe /q /componentargs "Enterprise
Developer:INSTALLDIR=c:\DirectoryName"

Installing Into Different Eclipse Packages
Micro Focus Enterprise Developer uses Eclipse 3.7. If you have an existing Eclipse 3.7 installation, no
further action is necessary, but if you want to use Enterprise Developer in other Eclipse packages based
on version 3.6, you must also install the Enterprise Developer update site, and the RSE and AspectJ
plugins. Follow the procedure below to do this.
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Important: We recommend you back up all existing Eclipse configuration files first.

1. Install Enterprise Developer as directed above.
2. Copy the required Enterprise Developer resources to your existing Eclipse as follows:

For Windows environments

1. Extract the contents of the following .zip files in %ProgramFiles%\Micro Focus\Enterprise
Developer\eclipse\installer to a temporary folder:

• ajdt_2.1.3_for_eclipse_3.7.zip

• RSE-runtime-3.3.zip

2. Copy the extracted folders to <your existing Eclipse>\eclipse\dropins.
3. Copy %ProgramFiles%\Micro Focus\Enterprise DeveloperEDUpdateSite to <your

existing Eclipse>\eclipse\dropins.
4. Rename each of the folders:

• From ajdt_2.1.3_for_eclipse_3.7 to AJDTUpdateSite
• From RSE-runtime-3.3 to RSEUpdateSite
• From EDUpdateSite to COBOLUpdateSite

5. Move the the contents of the <your existing Eclipse>\eclipse\dropins
\RSEUpdateSite\eclipse folder up a level (that is, to <your existing Eclipse>\eclipse
\dropins\RSEUpdateSite) and delete the empty folder.

6. Copy the eclipse.ini file in %ProgramFiles%\Micro Focus\Enterprise Developer
\eclipse\installer to <your existing Eclipse>\eclipse, overwriting the existing file.

3. Restart Eclipse.

Installing Micro Focus Enterprise Developer Unix
Components

Downloading the Product
1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the install instructions and the End User License Agreement.

Installing
Note:

During the installation process, the installer configures the product's Enterprise Server System
Administrator Process User ID. The Process User ID will be the owner of all Enterprise Server
processes except the one for the Micro Focus Directory Server (MFDS). The Directory Server
process (Enterprise Server Administration) runs as root as this allows it to access the system files and
ports.

All enterprise server processes you start from Enterprise Server Administration run under the Process
User ID which can affects the file access and creation.

By default, the installer uses the login id of the user that runs the installer for the Process User ID. To
change the user id after you complete the installation, execute $COBDIR/bin/casperm.sh.

To use the Web Installer:

1. Give the Web installer file execute permissions as follows:

chmod +x webinstaller_entdev_2.1_platform
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2. Run the installer from the Process User ID login:

./webinstaller_entdev_2.1_platform

When the installer starts it will prompt you to enter the superuser password so it can perform operations
that require root permissions.

3. If necessary, execute the $COBDIR/bin/casperm.sh script to configure the Enterprise Server
permissions and settings.

Alternatively, you can use the setup file and install the product as follows:

1. Give execute permissions to the setup file:

chmod +x setup_entdev_2.1_platform

2. Run the installer from the Process User ID login:

./setup_entdev_2.1_platform

When the installer starts it will prompt you to enter the superuser password so it can perform operations
that require root permissions.

The COBOL environment is installed by default into /opt/microfocus/EnterpriseDeveloper.

To install in a different location use the -installlocation="Location" parameter to specify an
alternative directory location. For example:

./webinstaller_entdev_2.1_platform -installlocation="full path of new 
location" 

or

./setup_entdev_2.1_platform -installlocation="full path of new location"

You can see details about which additional parameters can be passed to the install script if you enter
the -help option.

You can use the following options to configure the Enterprise Server installation: [ -
ESsysLog="location" ] [ -ESadminID="User ID" ] [ -CASrtDir="location" ],
where:

-ESsysLog Specifies a location in which the build will create the Enterprise Server System log file -
for example, -ESsysLog="/home/esuser/logs". The default location is /var/
mfcobol/logs.

-ESadminID Sets the Enterprise Server System Administrator Process User ID from the command
line - for example, -EDadminID="esadm". The default user ID is the one that runs the
installer.

-CASrtDir Specifies the location were the Enterprise Server run-time system files are placed - for
example, -CASrtDir="/home/esuser/casrt/es". The default location is /var/
mfcobol/es.

Note:

• The installation of this product could affect the SafeNet Sentinel licensed components running
on your machine. During installation licensing is shutdown to allow files to be updated. To
ensure the processes running on your machine are not affected, you need to use the –
skipsafenet option, which skips the installation of SafeNet:

./setup_entdev_2.1_platform -skipsafenet

• To protect the SafeNet Sentinel installation from accidental updating you can create an empty
file named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:

touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL
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While the file is present, the SafeNet installer does not make changes to the installation or
shutdown the running license daemons. If later licensing needs to be updated, remove the file
and install Sentinel RMS server manually.

Set Up the Environment

When you have installed the product, you need to set the environment as described below.

1. To set up your product, execute:

/opt/microfocus/EnterpriseDeveloper/bin/cobsetenv

2. To verify that your product is installed, execute:

cob -Version

Important: These commands set the environment only for the current shell. You need to execute
them for each new shell that you start.

To avoid having to run cobsetenv for every shell, add these commands to the shell initialization files
(etc/profile, etc/bashrc, etc.)

UNIX Installer Issues

License Infrastructure Installer

On some Solaris platforms, you can receive the following error message when SafeNet license server
needs to be installed or upgraded on your machine:

tar: /safenet.tar: No such file or directory

To resolve this issue, wait for the installation to complete and then perform the following:

1. Navigate to the safenet directory in the COBDIR location.
2. With superuser permissions execute: ./MFLicenseServerInstall.sh

License Server

On UNIX, you need to configure the computer hostname to ensure the license server will start properly.

To avoid performance issues, "localhost" and the computer hostname must not both be mapped to IP
address 127.0.0.1. You should only map "localhost" to IP address 127.0.0.1.

The following is an example of how to specify these entries correctly in the etc/hosts file:

127.0.0.1 localhost.localdomain localhost
IP machinelonghostname machineshorthostname

where IP is the unique IP address of the computer in xx.xx.xx.xx format.

Configuring the Remote System Explorer Support
The remote development support from the Eclipse IDE relies upon Enterprise Developer running on the
UNIX machine and handling all requests from the IDE for building and debugging programs. Enterprise
Developer provides a UNIX daemon, the Remote Development Option (RDO) daemon, which initiates the
RDO as Eclipse clients connect to it. Whichever environment is used to start the RDO daemon will be
inherited for all servers and hence all build and debug sessions.

Starting the Daemon

Important: Before starting the daemon you must have the following on your UNIX machine:

• a version of Perl
• a version of Java
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• the as (assembler) and ld (linking) programs on the path, as specified by the PATH environment
variable

To start the daemon on the default port (4075) as a background process, perform this command with
superuser authority:

$COBDIR/remotedev/startrdodaemon

The daemon will now listen for any Eclipse client processes connecting to that machine on port 4075. If
you want to use another port, then specify another port number on the startrdodaemon command.

The daemon can also be configured to instantiate the servers on a specified port or range of ports. This is
particularly relevant when you want to only open certain ports through a firewall. To do this, perform this
command with superuser authority:

$COBDIR/remotedev/startrdodaemon [<port> | <low port>-<high port>] 

where:

• <port> is the port number the daemon should use to listen for connections from Eclipse on the client
machine. If no value is given, it will be assigned a default value of 4075. This value matches the value
assigned within the Eclipse installation.

For example,

$COBDIR/remotedev/startrdodaemon 4999

This command will start a daemon listening on port 4999 and will use random server ports.
• <low port>-<high port> is the range of ports on which the servers (launched by the daemon) should use

to communicate with Eclipse on the client machine.

For example,

$COBDIR/remotedev/startrdodaemon 4080 4090-4999

This command will start a daemon listening on port 4080 and server ports will be in the range 4090 to
4999.

Stopping the Daemon

To stop the daemon, type the following command (with superuser authority):

$COBDIR/remotedev/stoprdodaemon <port>

Configuring the Environment

You may need to configure some aspects of the environment before you start the daemon. This is because
when a build or debug session is initiated from one of the Eclipse clients, the environment used will be
inherited from whatever was used to start the daemon. A typical example of the kind of environment that
might need to be set up would include database locations and settings for SQL access at build/run time.

Repairing
If a file in the installation of the product becomes corrupt, or is missing, we recommend to reinstall the
product.

Installing Mainframe Access Server
Introduction

The installation process for Mainframe Access Server uses a single FTP operation to transfer all of the
mainframe software into a partitioned data set that you pre-allocate. When this transfer is complete, the
remaining installation activities are all done on the mainframe. You customize and submit the pre-built
FRESTORE job to restore the product data sets from the uploaded files and then continue with
customization steps to create an operational Mainframe Access Server.
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Requirements

• IBM TCP/IP 4.0, or Interlink TCP/IP 3.1 or higher
• two APPLIDs, two TCP/IP ports
• APF security authorization support personnel availability
• Access to a network share with acceptable space for source and data, as well as the ability to access

the IP address and ports used to access MFA
• The following installation-specific variable information:

Variable Description

drive

userid TSO user-ID for FTP to your mainframe

pswd TSO password for the FTP user-ID

your.mainframe.name TCP/IP host name or IP address of your mainframe

prodhlq A NEW high level qualifier that will be assigned for all
Host Connectivity data sets when the new Mainframe
Access product is installed. These are NOT existing
product data sets, but rather brand new files that you
will be creating for this base version.

Important: The installation of a new version creates new product run-time data sets before the
upgrade is applied. Any existing Host Connectivity 3.01 libraries remain intact, and can be used for
fallback. If you prefer to retain your former production library names and re-use your existing
prodhlq then rename your old libraries beforehand.

Make a note of the maintenance level of your current Mainframe Access Server. Messages
MFM0001I and MFM0014I on the syslog and XDBOUT sysout data set show the maintenance
level at startup. You may need to know what level you are upgrading from when you complete
post-installation customizations for this upgrade.

Install Mainframe Access Server

In the instructions that follow, the information that you must provide is shown as one of the variable names
from the table of information in the previous section. For example, if your high-level qualifier (prodhlq) value
is MY.MFA, then substitute MY.MFA for prodhlq.

Follow these steps to load Mainframe Access Server:

1. Download the installation file from the link in your Electronic Product Delivery email and extract its
contents to a directory on the PC.

2. On the mainframe, allocate a new partitioned data set named prodhlq.UPLOAD to receive the uploaded
files. Use the following data set characteristics for this upload library:

DSORG=PO                   <=== PDS (partitioned data set)
RECFM=FB                   <=== record format fixed and blocked
LRECL=80                   <=== 80 character record size
BLKSIZE=3120               <=== 3120 character block size
SPACE=(3120,(3500,500,50)) <=== allocate blocks (BLKS) size 3120
                                3500 primary blocks
                                500 secondary blocks
                                50 directory blocks

3. On the PC, issue the following FTP commands. The actual text of the FTP prompts and responses that
you see may differ slightly from those shown in this example.

a. Start FTP:

C:\>ftpyour.mainframe.name
Connected to your.mainframe.name.
220-FTPD1 IBM FTP CS/390 VxRy at YOUR.MAINFRAME.NAME, hh:mm:ss
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220 Connection will close if idle for more than 5 minutes.
User (your.mainframe.name:(none)): userid
331 Send password please.
Password: pswd
230 userid is logged on. Working directory is "userid.".

b. Change the working directory on the mainframe to be the upload library that you allocated:

ftp> cd 'prodhlq.UPLOAD'
250 The working directory "hlq.UPLOAD" is a partitioned data set.

c. Set file transfer type to binary:

ftp> binary
200 Representation type is Image

d. Set FTP prompting off to transfer all files without interruption:

ftp> prompt
Interactive mode Off.

e. Transfer all files from the extracted \Upload directory to members in the prodhlq.UPLOAD library:

ftp> mputdrive:\upload\f*
200 Port request OK.
125 Storing data set prodhlq.UPLOAD(Fxxxxxxx)
250 Transfer completed successfully.        
ftp: xxxx bytes sent in x.xx seconds (xxx.xx Kbytes/sec)
.
.
.

f. When mput has transferred all files the ftp> prompt appears. End the FTP connection:

ftp> quit
221 Quit command received. Goodbye.        

g. On the mainframe, verify that all files transferred successfully and that for each Fxxxxxxx file in the
\Upload directory there is a corresponding member in the prodhlq.UPLOAD data set. There should
be 10 members, F1 through to F9 and FRESTORE.

4. On the mainframe, edit member FRESTORE in the upload library, prodhlq.UPLOAD. Follow the
instructions in that member to customize the JCL and then submit that job to restore the product
libraries from the uploaded files and populate your new product runtime libraries.

5. Start Mainframe Access Server.

After installation

Since the program libraries can change between versions, it is necessary to either create new procedures,
or back up the old procedures, and at least modify the DSNQUAL=prodhlq within your MFA sample started
task procedures as provided by Micro Focus. The prodhlq.LOADLIB and prodhlq.SASC.LINKLIB must both
be authorized.

Verify successful maintenance application by checking the Mainframe Access Server startup message:

MFM0001I: Mainframe Access V4.00 (BASE ) is active

The "(BASE )" indicates the product maintenance level. Also check for "V4.00" in the Mainframe Access
Data Connect server startup message:

MFA303I MFA/DATACONNECT V4.00 - BASE COPYRIGHT (C) 1987-2012 MICRO FOCUS...

When you are satisfied with the new version installation you may delete the UPLOAD data set from your
system.

New parameters and members in the CNTL samples data set

The following updated members are found in the CNTL data set.

MFA sample MFA started task

MFAS *new* sample MFAS started task for Data Connect
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MFAAS sample MFAAS application server started task

MFAVTAM sample MFA VTAM definitions

PARMS sample PARMS for MFA started task

PARMSAS sample PARMSAS for MFAAS started task

SERVERS sample SERVERS configuration for MFA

UPQUICK configuration notes

If you are migrating from Host Connectivity 3.01 WebSync 10 or earlier, you may want to retain your
existing CNTL members from your current version as an installation test. You can simply copy the existing
MFA started task JCL and change the STEPLIB to reference the new product libraries. You will however
be required to modify the MFAS started task JCL since the module names for Data Connect have been
changed to allow co-residence within the same authorized library as MFA.

Review the Change Log in each of the new members. Read the documentation for any new parameters in
the Readme and in the updated Mainframe Access Administrator's Guide. Add these new parameters and
other changes to your working copies. If necessary, customize the new parameters for your installation.

Once you are satisfied with the operation of Mainframe Access, you can consolidate the configuration
settings into the new high-level qualified CNTL members.

Installing the Mainframe Components

Mainframe zServer

The mainframe zServer is a z/OS server that supports the Eclipse mainframe integration, and is provided
with Enterprise Developer Personal Edition+ and Team Edition+ products. zServer needs to be installed
before mainframe access is enabled.

Refer to the document z/Server Installation Guide for instructions on how to install Enterprise Developer's
mainframe components.

To define
default
zServer
connections

Enterprise Developer supports the configuration of default connections. Default
connections can be defined by creating a file called defaultZConnection.ini in the
Eclipse folder of your Enterprise Developer installation.

The contents of this file must follow these syntax rules:

• Every line must contain one attribute or start with # (Comment)
• Every connection must start with >CONNECTION and end with >END_CONNECTION
• Every connection must be defined with following attributes:

NAME The name of the connection (must be unique)

HOST_ADDRESS The physical address of the host (for example 192.168.1.1,
localhost)

PORT The port of the zServer (scheduler)

DESCRIPTION The description of the connection - this can be left blank

A sample file is included in the installation.

When Enterprise Developer successfully parses the defaultZConnection file, it
creates a z/OS connection in the Remote Systems View for every configured default
connection.
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Important: Enterprise Developer reads the defaultZConnection file only once
for each workspace. This means that any changes relating to default connections
will not apply to existing workspaces that have already been used.

Assuming you have the appropriate Enterprise Developer Personal Edition+ or Team
Edition+ license, after installing zServer you should verify the connectivity.

To verify
mainframe
connectivity

1. Start Eclipse.
2. Ensure the Team Developer perspective is loaded. If it is not visible, select Window

> Open Perspective > Other > <Team Developer>.
3. Right-click in the Remote Systems view and select New > Connection.
4. Select "z/OS" from the connection list and click Next.
5. Enter the TCP/IP address or name of your mainframe system and enter a connection

name that will be displayed in the view. Click Next.
6. Enter the correct connection port and the default encoding parameters. Ask your

system administrator if you do not know the correct parameters.
7. Click Finish. The z/OS entry is added to the view.

To verify the
client host
connection

1. Start Eclipse and switch to the Team Developer perspective.
2. Expand the z/OS connection entry in the Remote Systems view. If the z/OS entry is

not shown in this view, verify the client installation process first.
3. Right-click on the MVS entry and verify, or customize, the port number of the zServer

server (the default is 1111).
4. Right-click on the MVS entry and select Connect.
5. Enter your mainframe user ID and password and click OK. After a successful

connection the color of the icons turns green.
6. Right-click again on the MVS entry and select Disconnect to disconnect from the

host system.

Mainframe Access server (MFA)

Mainframe Access is the OS/390 and z/OS server for Micro Focus development environments. It is a
common component providing access to host resources for environments. One installation of Mainframe
Access can support all of these products, providing connectivity to any number of DB2, IMS, and CICS
systems located anywhere in an enterprise. It can also provide access to JES facilities, VSAM data sets,
non-VSAM data sets, and data controlled by external library management products such as Panvalet,
Librarian and Endevor.

Features include:

• The Drag and Drop utility allows you to transfer files using drag and drop methods, between the
mainframe and the PC environments.

• The Remote Job Step Execution (RJSE) facility enables execution of one or more steps of a job on a
remote z/OS host. It automatically uploads and downloads required files as necessary with an end
result the same as when all steps are executed locally.

• Compare and Synchronization Monitor allows you to mirror mainframe data sets against either
workstation directories, or PVCS archives. This mirroring, known as synchronizing, can occur in either
direction, or both directions. Typically, a user would synchronize mainframe partitioned data sets or
source control systems with a workstation directory for download.

• You can use SourceConnect to map a PC drive to a mainframe dataset. You can then access
mainframe files and resources from a PC, or from applications running on a PC.
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After Installing
If you have used Eclipse from the same workspace before, the Eclipse perspective settings are not reset
after installating any Micro Focus product. To pick up any new features, you must reset the COBOL
perspective after installation:

1. Make sure you are in the COBOL perspective by clicking Window > Open Perspective > COBOL.
2. Click Window > Reset Perspective.
3. Click OK.
4. Reapply any customizations.

Installing X Windows on Windows
Some features of Enterprise Developer for Eclipse on Windows require an X Windows installation, hence
Micro Focus ViewNowX is provided with the product. To install, run the file ViewNow_X_Server.exe in
your Enterprise Developer installation. By default this will be in the %ProgramFiles%\Micro Focus
\Enterprise Developer\ViewNowX folder.

ViewNowX requires that your client machine has Microsoft Visual C++ 2008 SP1 Redistributable Package
(x86) installed. If it is missing from your machine, the ViewNowX installation will offer a link to download the
package.

Repairing
If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
Repair on the installation to replace them.

To repair your installation on versions of Windows Vista or later:

1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.

Uninstalling

Windows

To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:

1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programsin Control Panel.
3. On versions of Windows Vista and later, click View installed updates in the left-hand pane.
4. Select the product and click Remove or Uninstall, respectively.

When you uninstall, the only files deleted are those that the installation software installed. If the product
directory has not been removed, delete any unwanted files and subdirectories within it using Windows
Explorer.

Note: The installer creates separate installations for Micro Focus Enterprise Developer and Micro
Focus License Manager. Uninstalling only Enterprise Developer does not automatically uninstall the
Micro Focus Licensing Manager or any of the prerequisite software.

To completely remove the product you must uninstall the Micro Focus Licensing Manager as well.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

Installing Enterprise Developer | 17



UNIX

Note: Before you uninstall the product, ensure that the Enterprise Server Regions and the Micro
Focus Directory Service (MFDS) are stopped.

To uninstall this product:

1. Execute as root the Uninstall_EnterpriseDeveloper2.1.sh script in the $COBDIR/bin
directory.

Note: The installer creates separate installations for the product and for Micro Focus License
Manager. Uninstalling the product does not automatically uninstall the Micro Focus Licensing
Manager or the prerequisite software. To completely remove the product you must uninstall the Micro
Focus Licensing Manager as well.

To uninstall Micro Focus License Manager:

1. Execute as root the UnInstallMFLicenseServer.sh script in the /var/
microfocuslicensing/bin directory.

The script does not remove some of the files as they contain certain system settings or licenses.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.
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Enterprise Developer Editions and
Licenses

Enterprise Developer comes in the following variants:

Enterprise
Developer
Personal Edition

Enterprise Developer Personal Edition is a free product, available for download. It is
suitable for anyone who wants to become familiar with the Eclipse or Visual Studio
means of editing and compiling mainframe applications under Windows.

Enterprise
Developer

Enterprise Developer is for customers looking to modernize mainframe applications
and move to an alternative platform. This option again uses either the Visual Studio or
Eclipse-based IDE and includes development and test tools for all platforms currently
supported by Micro Focus.

Enterprise
Developer for z/
Enterprise

Enterprise Developer for z/Enterprise targets customers modernizing applications for
deployment back on the mainframe or any of the z/Enterprise partitions. This option
uses the Visual Studio or Eclipse-based IDE, mainframe integration and workflow
management. It also includes tools to support development and test on z/Linux and
AIX and x86 environments.

Both Enterprise Developer for z/Enterprise and Enterprise Developer are available for evaluation from
Micro Focus and both have concurrent and named user license options.

For more on the Micro Focus Licensing Administration Tool, see Licensing in the Enterprise Developer
help.

To activate Enterprise Developer Personal Edition
1. Start Enterprise Developer.

If you have not installed a license for the Team Edition of the product, starting the IDE for the first time
after you install the product opens the Micro Focus Enterprise Developer Product Licensing dialog
box. If you choose to cancel this dialog box, you can invoke it again from Help > Micro Focus >
Product Licensing.

a. If you purchased the license for the Team Edition of the product, click I have a full Enterprise
Developer Team Edition license and then click Finish.

b. If you do not have a license for the product, click I want to activate the free product.
2. If you haven't registered your email address yet, click registration page and follow the instructions on

that page.
3. Ensure that the email address you used to register the product is in the Email address text entry field.

You need to use the same email address you used for the registration.
4. Select one of the following options:

Automatic Use this if you have Internet access.

1. Click Finish to activate your copy of Enterprise Developer Personal Edition.

Manual Use this if you are not connected to the Internet.

1. Click Next and then click Send email.
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This opens your default mail client and creates a new email filled in with the details to
email to Micro Focus about activating your copy of the free Personal Edition product.
Send the email.

2. If there is no mail client installed on your machine, copy the email address, the subject
and the exact contents from the Email details fields and paste them into an email to
sent to Micro Focus using a mail client of your choice. Do not modify or add the text.

You will receive a response email with information with details about your authorization
request.

3. Paste the body text of the response email to the designated field in the Micro Focus
Product Licensing dialog box.

4. Click Finish.

You should receive a message that the activation has been successful.
5. Restart Eclipse to complete the activation process.

To request and activate a 30-days trial license for
Enterprise Developer Team Edition

1. In the IDE, click Help > Micro Focus > Product Licensing.

This opens the Micro Focus Enterprise Developer Product Licensing dialog box.

This dialog box also opens if you try to use a feature that is only available in Team Edition of this
product.

2. If you haven't registered your email address yet, click registration page and follow the instructions on
that page.

3. Type your email address in the Email address text entry field.

You need to use the same email address you used for the registration.
4. Select one of the following options:

Automatic Use this if you have Internet access.

1. Click Finish to activate the trial license for Enterprise Developer Team Edition.

Important: If, after you click Finish, you click the Cancel button in the progress
dialog box to stop the activation process, the trial license might have registered on
Micro Focus servers but not yet be registered on your machine. If you request a
trial again then you can get a message saying that a trial license has already been
used. If this happens, you should contact a Micro Focus Sales representative to
obtain a new license.

You can do this by sending an email to EDTEBuyNow@microfocus.com, or
selecting Help > Micro Focus > Buy Now and using the contact options in the
dialog box.

Manual Use this if you are not connected to the Internet.

1. Click Next and then click Send email.

This opens your default mail client and creates a new email filled in with the details to
email to Micro Focus about activating your trial of the Team Edition product. Send the
email.

2. If there is no mail client installed on your machine, copy the email address, the subject
and the exact contents from the Email details fields and paste them into an email to
sent to Micro Focus using a mail client of your choice. Do not modify or add the text.
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You will receive a response email with information with details about your authorization
request.

3. Paste the contents of the response email to the designated field in the Micro Focus
Product Licensing dialog box.

4. Click Finish.

You receive a message that the activation has been successful.
5. Restart Eclipse to complete the activation process.

After activation, you can see how many days your trial license has remaining by selecting Help > Micro
Focus > Product Licensing.

To request a 30-days trial license for Enterprise Developer Personal Edition+ and Team Edition+

Contact your Micro Focus Sales representative to request a 30-day trial license for Enterprise Developer
Personal Edition+ or Team Edition+.

To purchase a full unlimited license
1. In the IDE, click Help > Micro Focus > Product Licensing.

This opens the Micro Focus Buy Now dialog box.
2. Ensure that the email address you used to register the product is in the Email address text entry field.
3. Click Send email.

This opens your default mail client and creates a new email filled in with the details to contact Micro
Focus. Send the email.

If there is no mail client installed on your machine, you will be presented with a template that includes
the email address and subject line for an email to send to Micro Focus using a mail client of your
choice.

You will be contacted by a Micro Focus Sales representative.
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What's New
The following sections outline the new features that have been added in this release of Enterprise
Developer for Eclipse.

Features Added in Enterprise Developer 2.1
Note: There are differences between the two variants of Enterprise Developer you might have
installed. Enterprise Developer Personal Edition provides a development environment that supports
analysis, editing and syntax checking of COBOL and mainframe programs outside of the mainframe
environment. It does not, however, support off-mainframe debugging, unit testing and building of
projects. To build, debug, and execute the demonstration application, you need Enterprise Developer
Team Edition.

Enterprise Developer Enhancements

Building to .int, .gnt, and .lbr files

All sources for native COBOL and mainframe subsystem projects can be built to either .int or .gnt files,
and optionally bundled into an .lbr file.

Compiler directives

The following new Compiler directives are now available

• DISPLAY - Defines the default behavior of standard DISPLAY statements.
• COMP1 - Specifies the behavior of a COMP-1 data item.
• COMP2 - Specifies the behavior of a COMP-2 data item.
• RESTRICT-GOTO - Generates a syntax error for GO TO statements that transfer control to outside of

the current section.
• ILSMARTRESTRICT - Limits the generation of properties in ILSMARTLINKAGE classes to non-

redefining elementary items.

The following Compiler directives have changed:

• DATAMAP - Two new parameters allow you to display either the address or offset values for data items
in your program.

Enterprise Server

• CICS External Call Interface (ECI) - Micro Focus proprietary support for ECI is now available. ECI uses
the Micro Focus BINP protocol and negates the need for third-party middleware. For more information
about ECI support, read the section IBM External Call Interface (ECI) in your product help.

• Enterprise Server Batch Clustering is now available as a technology preview. Features include:

• Support for sharing of both the catalog and spool between multiple batch regions is included as a
technology preview.

• Allows multiple batch regions to share commonly configured resources by providing global locking
facilities to manage contention.

For further details about this feature, contact your Micro Focus technical account management team.
• Micro Focus Batch Scheduler Integration solution - enables you to submit, execute, and feedback

between Enterprise Server and a scheduler that controls JCL job execution.
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• Support for running TSO commands in a TSO batch session using the IDAEFT01 (IKJEFF01) utility is
now available.

• The mfds –x export command line option has been extended to support repository export to an XML-
format file. The syntax is as follows:

mfds -x [repository type] [repository address] [server name] <opts> <user 
id> <password>

Where:

[repository type] • 1 = file:///
• 5 = XML

[server name] * = export all servers

<opts> • D = (default) do not delete or overwrite any existing repository contents
at specified location

• O = delete and overwrite any existing repository contents at specified
location

• S = export server and security manager configuration

<user id> and
<password>

the MFDS credentials required if administration access is restricted

• The new –g option is used to allow XML format repository import. The syntax is as follows:

mfds -g [repository type] [repository address] <opts> <user id> <password>

[repository type] 5 = XML

<opts> Not currently in use.

• XML repository import - extends the MFDS repository export to XML and import from XML introduced in
Enterprise Developer 2.0 to UNIX platforms. This allows administrators to export, modify and then
reimport Enterprise Server instance configuration data in XML format.

Mainframe Access

Eclipse-
based
Drag and
Drop GUI

This release provides a new Eclipse-based Drag and Drop GUI (mfdasmx2) which replaces
the GUI used previously, mfdasmx.exe.

MFA
Server

MFA Server has been updated to version 4.00 (BASE), and provides the following
enhancements:

• Double-byte character support using the following code pages:

Traditional Chinese with Taiwanese additions (BIG5)
Korean (KSC5601)
Simplified Chinese (SCHINESE)
Japanese - Kanji (SJISKANJI)
Traditional Chinese (TCHINESE)

• Additional qualifiers for use with the new code pages:
default

EBCIDIC SI/SO added on upload, removed on download

-SOSI-K
EBCIDIC SI/SO assumed on upload, preserved on download

-SOSI-A
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ASCII SI/SO assumed on upload, preserved on download

-SOSI-S
Spaces converted to SI/SO on upload. SI/SO converted to spaces on
download

Note: This will only work correctly with text that
originates on a host.

IMS support

• Mainframe projects contain categories for IMS resources (.dbd, .mfs, and .psb files), in which files
with these extensions are automatically put when you add them to the project. Each file type has its
own editor that colorizes tokens to aid development. Building a project containing these file types
automatically generates DBD. PSB, and MFS files.

• Non-discardable message exit (early release) - provides you with functionality present in Mainframe
IMS that allows messages destined for an abended IMS application program to be deleted, put on the
suspend queue, requeued to the original transaction, or routed to an alternate destination.

• IMS printer support (early release) - IMS application LU1, LU3 MFS, or LTERM output can now be
spooled to printers using TCP/IP protocols. You now have the ability to print IMS output on local or
networked printers.

Note: Print spool API support is not available. Users are responsible for associating printers with a
user or a department.

Just-in-time debugging

Eclipse now supports "Just-in-time" debugging: when a run-time error occurs, or an application calls
CBL_DEBUGBREAK, Eclipse starts automatically with the debugger attached to the failed process.

Tutorials

The following tutorial is now available in the Getting Started section in your product help:

Tutorial:
Assembler

AACT is a sample CICS 3270 transaction that comprises several Assembler programs
and a single BMS map, and uses the resource definitions in the file dfhdrdat. This
tutorial walks you through the steps required to implement and test the AACT
transaction.

Managing the
Mainframe in Eclipse

This tutorial shows you how to develop and debug applications on or off the
Mainframe. The tutorial is based on the Bankdemo sample application.

UNIX and Linux platforms support

Micro Focus Enterprise Developer Unix Components enables you connect to remote UNIX machines and
use them to create, edit, and debug all project types. The following systems are supported:

• POWER running AIX 6.1, 6.6, 7.2 - 32/64-bit
• x86-64 running Red Hat Linux 5.5, 5.8, 6.2, Oracle Linux 6.2 (Red Hat Kernel compatibility mode) -

32/64-bit
• Oracle Linux 6 Update 2 with Unbreakable Enterprise Kernel Release 2
• SPARC running Solaris 10, 11 - 32/64-bit
• x86-64 running SuSE SLES 11, 11 SP2, Oracle Linux 6.2 (Red Hat Kernel) - 32/64-bit
• 390 running SuSE SLES 11 SP1 - 32/64-bit
• Itanium running HP/UX 11.31 - 32/64-bit
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Working with mainframes

Enterprise Developer Team Edition+ now includes direct access to the mainframe from within Eclipse. This
functionality provides the following features:

Direct access to
the mainframe

The mainframe environment is integrated directly into the Eclipse IDE. Developers can
use the Remote Systems Explorer view to the mainframe and directly access it with
the JES Explorer and MVS Explorer views to:

• Browse and edit their data sets
• Edit and Submit jobs for execution
• Run ISPF dialogs
• Review Job output on the spool or catalog

Remote
Mainframe
Development

Developers now have full control of development activities directly on the mainframe.
This means from within a single IDE you can:

• Integrate directly to mainframe source control systems to check out, check in, and
promote members directly to your personal mainframe area.

• Use smart editing capabilities such as - Background Parsing to detect syntax errors
as they are entered; Content Assist when writing COBOL code; Source Outline
view and navigation when editing programs that are on the mainframe.

• Syntax check and compile applications directly on the mainframe while the error
messages are output to the Eclipse editor which ensures compilation issues can be
quickly viewed and resolved.

• Unit test applications on the mainframe, and even run debug sessions directly from
the Eclipse IDE if you have the debugging tools on the mainframe.

Easy
customization

Enterprise Developer includes a unique component called Workflow Manager, a
graphical modeling tool that allows you to customize quickly the Enterprise Developer
Eclipse-based User Interface and directly integrate tools, such as source control,
either directly on the mainframe, or on the workstation. This means that your
development environment is fully customizable and you can integrate familiar
development workflow in Eclipse. Workflow Manager means:

• Complete integration with major source control systems out-of-the-box becomes
possible.

• You can create predefined models to support different development processes.
These can be managed and deployed centrally.

• There is no requirement to develop Eclipse JAVA plugins in order to extend the
IDE User Interface which puts you in control.

• Comprehensive and deep integration becomes affordable.
• Developer acceptance is high and productivity gains are realized.

General Enhancements

JVM auto-runtime

If you are developing a COBOL JVM project, you don't have to choose whether to use the native or pure
JVM file handling systems. You can use just one runtime that configures itself for the environment it is
executing in.

Managed code enhancements

Delegates
and Events

Delegates and events are now implemented on the JVM platform.
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This release provides support for combining delegates, using the METHOD keyword to
specify method groups, and implicit conversion from a method group or an anonymous
method to the suitable delegate type.

Handling
Invalid
Numeric
Data

The handling of invalid numeric data is controlled by a number of Compiler directives:
HOSTNUMMOVE, HOSTNUMCOMPARE and SIGNFIXUP. These directives were
previously only available in native code but are now supported in managed code.

Resolving
Types

In this release, the Compiler attempts to resolve types to those defined in the current
compilation unit wherever possible. The Compiler will attempt to resolve such types to an
external name only if no suitable type exists in the current compilation unit. For example:

$set ilusing"System"
class-id MyNamespace.EventHandler.
01 o type EventHandler.                       
end class.

In this release, 01 o type EventHandler. resolves to
MyNamespace.EventHandler and not to System.EventHandler.

Specifying
Properties

In previous versions of the products, properties declared using the PROPERTY keyword
on a data item were generated as final properties. Starting with this release, they are
generated as virtual properties by default. In order to make the properties final, you need
to specify the word FINAL following PROPERTY. This change may affect the generation
of Proxy classes, for example, if you are using WCF.
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Known Issues
Please, refer to the Known Errors and Restrictions topic in the Product Information section of your product
Help.

In addition, please note the following:

COBOL
Watchpoints

The debugger ignores a COBOL watchpoint that is hit if there is no statement
following the statement that modifies the data on which that watchpoint is set.

Documentation The tutorial Getting Started with Micro Focus Enterprise Developer Team Edition for
Eclipse includes an incorrect folder path. In the topic Importing the Bankdemo
Project and Adding the Source Files, in the section "Importing the Bankdemo
Project", and in step 4, the tutorial points you to the C:\MFETDUSER\Bankdemo
\Sources path. This is incorrect.

You need to browse to the %PUBLIC%\Documents\Micro Focus\Enterprise
Developer\Samples\Mainframe\BankDemo\Workspace\ folder instead.

ICETOOL
Emulation

ICETOOL emulation for managed code is not available in this release.

Enterprise Server On versions of Windows Vista and later, Enterprise Server listens only on the IPv4
loopback address (127.0.0.1). As a result, an attempt to connect to localhost with a
TN3270 emulator such as RUMBA may fail. To work around this issue, in your
emulator's configuration use 127.0.0.1 in preference to localhost or your host
machine's name.

Wait for
Attachment
Debugging

There is an issue with "Wait for attachment" when you use Enterprise Developer for
Eclipse to debug applications that run on some Linux/Unix platforms. Eclipse
connects to the debugger on the remote machine, but might not attach to the
process to debug the code.

To work around this issue, ensure that on the remote machine the TMPDIR
environment variable is unset or has the same value for both Micro Focus Enterprise
Developer Unix Components server and for the running process you wish to debug.
The Micro Focus Enterprise Developer Unix Components server is the server which
you started either directly with the $COBDIR/remotedev/startrdoserver script or
indirectly using the daemon which is started with the $COBDIR/remotedev/
startrdodaemon script.

To check the variable used by the Micro Focus Enterprise Developer Unix
Components server:

1. Open Remote Systems view in Eclipse on the Windows machine.
2. Right-click the Shells element of the server connection to be tested and click

Launch Shell.
3. In the Remote Shell view, type echo $TMPDIR in the Command field, and

press Enter.

The value of the TMPDIR environment variable is shown - ensure it is the same
as the one used by the process to be debugged.

Note: The value of TMPDIR used by the Development Hub server cannot
be changed in the remote shell and must be set before you start the
daemon or server.
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Resolved Issues
The resolved issues that customers have reported are listed in this section. The numbers that follow each
issue are the Reported Problem Incident number followed by the Customer Incident Numbers (in
parentheses). RPIs that have numbers only (and no text) are included to confirm that the RPIs have been
fixed, since no further information is required.

• CAS Security
• CAS XA Switch modules
• CCI TCP/IP
• Compiler
• Data Tools editor
• Documentation
• Eclipse IDE
• File Handling - External File Handler
• File Handling - Fileshare
• File Handling - Sort / JCL Sort
• JVM Compiler
• JVM Run-Time System
• MF Directory Server
• MFIO
• MTO - CICS ECM/Preprocessor/Translator
• MTO - CICS ESMAC
• MTO - JCL Utils
• MVS REXX Emulation
• Run-Time System
• SQL: COBSQL
• SQL: DB2 ECM
• SQL: OpenESQL
• Vision File System
• XDB DCLGEN Utility
• XDB Server
• XML syntax support runtime

CAS Security

• The MLDAP ESM Module can now be configured to support an additional wildcard character, "+", which
matches any one character in the resource, user, or group name. To enable this wildcard, set "plus-
wildcard=yes" in the [Operation] section of the Security Manager configuration area.

1083460 (2565125)

CAS XA Switch modules

• The XA build script has been updated to resolve an issue using the 64-bit DB2 XA switch module on
x86-64 platforms running Linux.

1083129 (2560501)
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CCI TCP/IP

• CAS utilities such as cassub or casout, and COBOL Web Service clients, no longer timeout prematurely
when used with an SSL-enabled connection.

1082906 (2557202)

Compiler

• The DBCSSOSI directive now compiles correctly.

590357 ( )
• DISPLAY MESSAGE BOX ... RETURNING syntax now returns an E-level error message stating that it

is unsupported in this COBOL system.

584600 ( )
• You can now configure the DATAMAP clause to output either addresses or offsets. DATAMAP(ADDR)

or DATAMAP with no option shows addresses. DATAMAP(OFFSET) shows offsets. Compile managed
COBOL code sets DATAMAP(OFFSET) at the end of directive processing as addresses are not
available for managed code.

1054182 (2093752)
• Compilation of ACU DISPLAY windowing syntax will no longer receive spurious internal error messages

during a background syntax check.

591227 ( )
• Compiling with a large number of ADDSYN directives specified now works as expected.

1083917 (2567767)
• The maximum value for the PAGE LIMIT clause has been increased from 999 to 9999.

1084391 (2576431)
• DISPLAY(CONSOLE) is a new directive available to override the behavior set by RM or ACU directives,

so that standard DISPLAY syntax is processed as standard ANSI DISPLAYs, directed to CONSOLE.
RM and ACU directives set DISPLAY(CRT) immediately, allowing you to set DISPLAY(CONSOLE)
after either of those directives, if required.

1084496 (2577799)
• A compiler bug that produced illegal int-code for "call ... returning pointer-item" under DIALECT(RM)

has been fixed.

1085375 (2586367)

Data Tools Editor

• The Data File Editor now allows editing of an EBCDIC data file on a DBCS OS.

1083716 (2567163)

Documentation

• Information detailing the process of XML-enabling COBOL applications that was previously left out of
the Visual COBOL documentation has been reinstated and is now available under Programming >
COBOL Programming > XML Input/Output.

1084142 (2573343)
• When entering the path of the IBM MQ libraries for the ES_MQ_LIB and ES_MQ_LIB_XA environment

variables, in AIX environments the library must be an object inside a shared object.

1084692 (2578515)
• When you create or edit a CICS SIT resource in ESMAC, the paths of recoverable and non-recoverable

temporary storage queues are now specified in separate fields, Path (rc) and Path (nr).
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1084877 (2578440)

Eclipse IDE

• Specifying "use(cobol.dir)" in the COBOL build settings no longer generates errors when a program is
open in the Editor.

1082324 (2548143)
• The values that the Variables View shows when you debug with "Display hexadecimal values" or

"Display byte values" settings enabled have been changed.

589220 ( )
• You can now specify in the IDE whether directories that you add to the project should be added to the

copypath. You configure this in the project's properties under Micro Focus COBOL > Build Paths, and
on the Copybook Paths tab.

589096 ( )

File Handling - External File Handler

• Reading IDXFORMAT"9" records non-transactionally over fileshare no longer causes any issues.

1083646 (2566578)
• When opening a mainframe file for input, the file is now not optional as per the mainframe.

1082362 (2506971)
• When attempting to OPEN I/O a read-only file using the RM/COBOL File Handler, a 37, 07 error

message is displayed if the program is running in ANSI85 mode. The error message is not displayed if
the program is running in ANSI74 mode.

1084329 (2573607)
• Cobfhrepro now works correctly when session id is specified.

590271 ( )
• Invalid XML syntax in MF.MFFH.XML has been corrected.

589406 ( )
• The maximum field length that MFSORT supports for PD summary fields is extended from 9 bytes to 18

bytes.

1084961 (2581353)

File Handling - Fileshare

• If you are accessing RM/COBOL files through Fileshare, the RETRYLOCK option is now working
correctly.

1084744 (2579930)
• Closing a file using FSVIEW now correctly removes the file from fileshare's open file table.

587706 ( )
• The FSVIEW option 'stats get' gives the statistics for current users, peak users, file opens and peak file

opens. The corresponding FSVIEW API is FSV-C-get-stats.

1083664 (2567737)
• FSVIEW will no longer process the last command in a command file twice.

589764 ( )

File Handling - Sort / JCL Sort

• The informational "Operand 'VLSHRT' Ignored" message has been removed from the sort sysout.

30 | Resolved Issues



1083225 (2562501)
• Using SYMNAMES sometimes caused SORT to use the wrong field position and lengths.

1083320 (2563738)
• Data format FI is now supported in the OUTREC edit fields section.

1083495 (2565051)
• SORT now works correctly when there are concatenated VB files with different record lengths in

SORTIN.

1084194 (2573990)
• SORT now gracefully handles the error when there is an INCLUDE/OMIT condition with invalid HEX/

Binary digit.

1084231 (2574465)
• SORT now ignores the operand 'WORK' along with its value.

1081023 (2533397)
• A sort using SORTTEMPSPACE no longer ever results in a COBRTS 252 error.

1081943 (2546898)
• CENTWIN and Y2PAST are now supported as PARMS.

1080717 (2531364)
• The MFSORT help screen now shows that OPTION is supported.

590260 ( )
• SORT worked incorrectly for multiple fields to be converted in INREC/OUTREC/OUTFIL OVERLAY

syntax.

1084481 (2577157)
• The TOTAL field length calculation now works correctly when TOTALs are zeros.

1082887 (2558079)
• Trailers are now included in the SYSOUT outfil record count.

1084193 (2573272)
• Records following HEADER2 and HEADER3 will now be the correct length.

590270 ( )
• Header lengths are now calculated correctly, taking line feeds into account instead of giving a

SORT099I error. Headers will now be printed for outfiles that do not have any records.

1083701 (2565909)
• SORT now works correctly when SYSIN is given as LSEQ PDS Member.

1082529 (2550678)
• When using MFJTOOL with a VB input file, an appropriate error is thrown when the output file is not VB

or has not worked successfully when the output file is VB. Previously, a COBRTS 139 error was thrown.

1084567 (2577626)
• Sort now works correctly when OPTION COPY is given before the SORT FIELDS in SYSIN.

1083679 (2565053)
• SORT caused different sort processing for large sort cards. This has been fixed so SORT now returns

an error message and exits the sort processing when the sort card has more than 1024 INCLUDE/
OMIT conditions.

1084065 (2571660)
• When using MFSORT, smaller records are padded to the size of the minimum record length of a VB file

and the record length is changed to the minimum of sortout.

1082943 (2554482)
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• Sort now displays HEADER2 at the start and TRAILER2 at the end of each page.

1083702 (2566545)

JVM Compiler

• Java verification errors or incorrect program flow occurring in very large JVM COBOL programs is now
fixed. Previously, in very large programs, the compiler would process GO TO statement incorrectly, and
could jump to the wrong program locations.

1084569 (2578716)
• Some problems with the use of nested classes defined in COBOL have been resolved.

1083183 (2561420)

JVM Run-Time System

• A stack overflow no longer occurs if you execute a call to a method inside a constructor and this method
contains a COBOL statement. Previously, the runtime would jump back to the constructor and go into a
loop, producing a stack overflow.

1083181 (2561418)
• The JVM COBOL library routines CBL_DIR_SCAN_ now return the correct results when searching for

directories.

590261 ( )

MF Directory Server

• A problem with some of the security configuration pages in the Enterprise Server Adminstration HTML
GUI not being displayed correctly in Mozilla Firefox Web browser has been resolved.

592374 ( )
• When you used Enterprise Server Administration to create a new security resource entity, the initial

ACL string value was displayed as an incorrect value.

592375 ( )
• In Enterprise Server Administration, if a server listener has been defined to use SSL, the "Authorise"

URL now uses a hostname instead of an IP address if the Communications Process Control Channel
listener has been defined using a hostname address. This avoids potential issues where the IP address
might be invalid on a remote client because of NAT configuration.

1083989 (2563805)
• If MFDS_DNS_RESOLVE=Y is set in the MFDS process, you could get sign on errors. These was

caused by the HTML GUI "Log On" menu option URL using the IP address and not the fully qualified
hostname. These issues have now been fixed. As well as resolving the NAT address issues for remote
clients, the HTML GUI "Log On" menu option also allows browser clients to connect to the GUI without
receiving a certificate warning. This has been fixed in versions of the MFDS 1.14.27 and later.

1084209 (2573815)
• On Solaris platforms, attempting to access the Historical Statistics Facility for an Enterprise Server

instance from the Enterprise Server Administration console causes the MFDS process to terminate.

592029 ( )

MFIO

• Logons to MFA sometimes failed because the userid or password contained zeros.

1082548 (2552652)
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MTO - CICS ECM/Preprocessor/Translator

• The WEB OPEN function is supported.

1081796 (2545562)

MTO - CICS ESMAC

• If external security is configured (MLDAP) and the default ESMAC user is not allowed to login, the
region does not startup.

1082337 (2550800)

MTO - JCL Utils

• In IEBGENER, if the SYSUT1 dataset is a DUMMY dataset it will now be processed as an empty
dataset.

1083514 (2565707)

MVS REXX Emulation

• The DATE() function now formats the year correctly when converting between a Julian and a standard
date format.

1083437 (2564240)
• The LISTDSI external function now correctly sets values for the SYSREFDATE and SYSMGMTCLASS

variables.

1084902 (2581611)

Run-Time System

• The call MVS_REGISTER_DDNAME is an MFE-only call used by the IDE. FileHandler no longer calls
this routine.

1083028 (2559292)
• IF NUMERIC validation of COMP-3 slack nibbles (when there is an even number of digits in the picture

clause) is now done in a way that is compatible with that on the mainframe.

1083801 (2569340)
• The RUN program now accepts command line arguments of up to 1023 characters long.

1083215 (2561567)
• When running a full-screen application inside a terminal emulator on Linux, the actual size of the

terminal is read at startup and reread when the terminal is resized. This behaviour is also supported on
AIX, HP/UX, and Solaris. The Micro Focus vt220 terminfo entry now correctly describes a 24-line
display. A vt220-25 terminfo entry is included for compatibility with the previous behaviour.

1084817 (2579335)

SQL: COBSQL

• The Cobsql preprocessor was updated to no longer misinterpret WORKING-STORAGE items whose
definitions were spread across multiple source lines.

1080078 (2507684)
• The Cobsql preprocessor has been updated to correctly process variables defined as USAGE COMP

after an EXEC SQL INCLUDE SQLCA when the CP preprocessor directive NOSQL is specified.

1084463 (2577593)
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• The Cobsql preprocessor has been updated to correctly process Pro*COBOL-generated data items
when the first WORKING-STORAGE variable in user code contains a VALUE clause with the literal
value on a separate source line.

1084753 (2579264)

SQL: DB2 ECM

• The DB2 pre-compiler now generates GOBACK instead of STOP RUN at the end of program source,
so that poorly coded programs do not fail when running under IMS or other transaction monitors.

1083235 (2559616)

SQL: OpenESQL

• The OpenESQL preprocessor has been updated such that when a program or application is compiled
with the SQL(DBMAN=ADO) compiler directive, the calls generated do not modify user data when a null
value is returned.

1083563 (2561563)
• The OpenESQL preprocessor no longer accepts singleton select statements that have no INTO clause,

or host variables that are not preceded by a colon, apart from SQLDA references in dynamic SQL. In
rare cases where a singleton select without an INTO clause is required, code it by placing the SELECT
statement inside of a BEGIN/BEND block.

1084430 (2576585)
• The ODBC Compiler did not identify specialized classes such as ENUMS, and incorrectly generated

SQL interface code for them that caused Compiler errors. The ODBC Compiler has been enhanced so
that it no longer generates SQL interface code for those classes.

1083144 (2561349)
• Previously, the SQL pre-compilers did not always recognized the EXEC SQL INCLUDE statements

during the syntax checking phase and returned incorrect error messages.

1085057 (2582967)

Vision File System

• When you configure your application to return RM/COBOL file status codes, by setting
COBFSTATCONV=rmstat, the codes returned are ANSI'85 codes.

1082469 (2553438)

XDB DCLGEN Utility

• A protection violation sometimes occurred when you used the XDB Declaration Generator tool on 64-bit
Windows platforms.

591030 ( )

XDB Server

• Support has been added to enable the execution of DESCRIBE INPUT statements.

1079821 (2508551)
• A mutex deadly embrace no longer results in a server hang.

1085199 (2583889)

XML syntax support runtime

• An issue with the PREXML preprocessor has been resolved and it now does not truncate data names
longer than 30 characters.
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1085342 (2586384)
• In previous releases, the documentation for XML Input/Output was missing from the online help. This

documentation is now included in the online help.

1084119 (2572393)
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Updates and SupportLine
Our Web site gives up-to-date details of contact numbers and addresses.

Further Information and Product Support
Additional technical information or advice is available from several sources.

The product support pages contain a considerable amount of additional information, such as:

• The WebSync service, where you can download fixes and documentation updates.
• The Knowledge Base, a large collection of product tips and workarounds.
• Examples and Utilities, including demos and additional product documentation.

To connect, enter http://www.microfocus.com in your browser to go to the Micro Focus home page.

Note: Some information may be available only to customers who have maintenance agreements.

If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, www.microfocus.com. If you obtained the product from another source, such as an authorized
distributor, contact them for help first. If they are unable to help, contact us.

Information We Need
However you contact us, please try to include the information below, if you have it. The more information
you can give, the better Micro Focus SupportLine can help you. But if you don't know all the answers, or
you think some are irrelevant to your problem, please give whatever information you have.

• The name and version number of all products that you think might be causing a problem.
• Your computer make and model.
• Your operating system version number and details of any networking software you are using.
• The amount of memory in your computer.
• The relevant page reference or section in the documentation.
• Your serial number. To find out these numbers, look in the subject line and body of your Electronic

Product Delivery Notice email that you received from Micro Focus.

On Windows, if you are reporting a protection violation you might be asked to provide a dump ( .dmp) file.
To produce a dump file you use the Unexpected Error dialog box that is displayed when a protection
violation occurs. Unless requested by Micro Focus SupportLine, leave the dump setting as Normal
(recommended), click Dump, then specify a location and name for the dump file. Once the dump file has
been written you can email it to Micro Focus SupportLine.

Alternatively, you might be asked to provide a log file created by the Consolidated Tracing Facility (CTF) -
a tracing infrastructure that enables you to quickly and easily produce diagnostic information detailing the
operation of a number of Micro Focus software components.

On UNIX, you can use the Micro Focus UNIX Support Scan Utility, mfsupport, to create a log file that
contains the details about your environment, product, and settings. The mfsupport script is stored in
$COBDIR/bin.

To run mfsupport:

1. Start a UNIX shell.
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2. Set COBDIR to the product with issues.
3. Execute mfsupport from a directory where you have write permissions.

This creates a log file, mfpoll.txt, in that directory.
4. When the script finishes, send the mfpoll.txt file to your Micro Focus SupportLine representative.

Note:

If COBDIR is set to a location which does not contain etc/cobver, the script outputs the contents
of /opt/microfocus/logs/MicroFocusProductRegistry.dat which keeps a list of the
installedMicro Focus products.

Creating Debug Files
If you encounter an error when compiling a program that requires you to contact Micro Focus technical
support, your support representative might request that you provide additional debug files (as well as
source and data files) to help us determine the cause of the problem. If so, they will advise you how to
create them.
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Disclaimer
This software is provided "as is" without warranty of any kind. Micro Focus disclaims all warranties, either
express or implied, including the warranties of merchantability and fitness for a particular purpose. In no
event shall Micro Focus or its suppliers be liable for any damages whatsoever including direct, indirect,
incidental, consequential, loss of business profits or special damages, even if Micro Focus or its suppliers
have been advised of the possibility of such damages. Some states do not allow the exclusion or limitation
of liability for consequential or incidental damages so the foregoing limitation may not apply.

Micro Focus is a registered trademark.

Copyright © Micro Focus 1984-2012. All rights reserved.

This product includes software developed by Computing Services at Carnegie Mellon University (http://
www.cmu.edu/computing/)".
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